PLANNING AND CONTROL
USING
ORACLE® PRIMAVERA® P6
Versions 8.2 to 15.1 EPPM WEB
“Enterprise Portfolio Project Management”

Planning and Progressing Project Schedules
With and Without
Roles and Resources
in an
Established Database

BY

PAUL EASTWOOD HARRIS
INTRODUCTION

This publication is an upgrade of the author's unpublished book Project Planning & Control Using Primavera P6 Web Interface - One Day Training Course and has been written to enable new users to learn the planning and scheduling functions of Primavera Versions 8.2 to 15.1 EPPM (Enterprise Portfolio Project Management) Web Client. Please note there are no versions 9 to 14 and Oracle changed their naming convention with the release of 15.1 so the name is the same as the year of the release.

Many users will have prior experience with the P6 Windows Client, SureTrak, P3, Asta Powerproject or Microsoft Project and the author explains where there are differences in the products' functionality.

The author would appreciate any constructive comments on how this publication may be improved. Feedback can be submitted to www.eh.com.au.

SUMMARY

The publication may be used as:

- A training manual for a training course, or
- A self-teach book, or

The screen shots for this publication are taken from Primavera Versions 8.2 to 15.1 EPPM Web Client.

A training course may be run using this publication and it includes exercises for the students to complete at the end of each chapter. After the course, students may use this publication as a reference book.

Instructors' PowerPoint presentations are available from Eastwood Harris web sites.

This publication is ideal for people who would like to quickly gain an understanding of how the software operates and explains how the software differs from the Primavera P6 Windows Client, P3, SureTrak, Asta Powerproject and Microsoft Project, thus making it ideal for people who wish to convert from these products.

CUSTOMIZATION FOR TRAINING COURSES

Training organizations or companies that wish to conduct their own training may have this publication tailored to suit their requirements. This may be achieved removing, reordering or adding content to the publication and by writing their own exercises. Please contact the author to discuss this service.

AUTHOR’S COMMENT

As a project controls consultant I have used a number of planning and scheduling software packages for the management of a range of project types and sizes. The first publications I published were user guides/training manuals for Primavera SureTrak, P3 and Microsoft Project users. These were well received by professional project managers and schedulers, so I decided to turn my attention to Primavera Enterprise / Primavera P6 after a request from Primavera Systems Inc. to write a book. This publication follows the same proven layout of my previous publications. I trust this publication will assist you in understanding how to use Primavera P6 on your projects.

APPRECIATION

I would like thank Michael Jack, Ran Sun and Jan Hanak for their assistance in writing this book. I would also like to thank Jesica Paula Yabo for her assistance in updating this book from Version 8.2.
CURRENT BOOKS PUBLISHED BY EASTWOOD HARRIS

99 Tricks and Traps for Microsoft Office Project - Including Microsoft Project 2000 to 2007
Planning Using Primavera Project Planner P3 Version 3.1 - Revised 2006
Planning Using Primavera SureTrak Project Manager Version 3.0 - Revised 2006
Project Planning and Scheduling Using Primavera Contractor Version 6.1 - Including Versions 4.1, 5.0 and 6.1
Planning and Control Using Microsoft Project and PMBOK Guide Fourth Edition
Planning and Control Using Microsoft Project 2010 and PMBOK Guide Fourth Edition
Project Planning & Control Using Primavera P6 Version 7 - For all industries including Versions 4 to 7 Updated 2012
Planning and Scheduling Using Microsoft Project 2010 - Updated 2013 Including Revised Workshops
Planning and Control Using Microsoft Project 2010 & PMBOK Guide Fifth Edition
Planning and Control Using Microsoft Project 2013
Planning and Control Using Oracle Primavera P6 - Versions 8.2 & 8.3 EPPM Web
PLANNING AND CONTROL USING ORACLE® PRIMAVERA® P6 VERSIONS 8.2 to 15.1 EPPM WEB

PLANIFICACIÓN Y CONTROL USANDO ORACLE PRIMAVERA P6 VERSIÓNES 8.1 A 15.1 PPM PROFESIONAL

SUPERSEDED BOOKS BY THE AUTHOR

Planning and Scheduling Using Microsoft® Project 2000
Planning and Scheduling Using Microsoft® Project 2002
Planning and Scheduling Using Microsoft® Project 2003
Planning and Scheduling Using Microsoft® Office Project 2007
PRINCE2™ Planning and Control Using Microsoft® Project
Planning and Control Using Microsoft® Project and PMBOK® Guide Third Edition
Project Planning and Scheduling Using Primavera Enterprise® – Team Play Version 3.5
Project Planning and Scheduling Using Primavera Enterprise® – P3e & P3e/c Version 3.5
Project Planning and Scheduling Using Primavera® Version 4.1 for IT Project
Project Planning and Scheduling Using Primavera® Version 4.1 or E&C
Planning and Scheduling Using Primavera® Version 5.0 – For IT Project Office
Planning and Scheduling Using Primavera® Version 5.0 – For Engineering & Construction
Project Planning & Control Using Primavera® P6 – Updated for Version 6.2
Planning Primavera Project Planner P3® Version 2.0
Planning Primavera Project Planner P3® Version 3.0
Planning Primavera Project Planner P3® Version 3.1
Project Planning Using SureTrak® for Windows Version 2.0
Planning Using Primavera SureTrak® Project Manager Version 3.0
Planning and Control Using Oracle Primavera P6 - Version 8.1 Professional Client & Optional Client
Planning & Control Using Primavera® P6™ For all industries including Versions 4 to 7
Planning and Control Using Oracle Primavera P6 - Versions 8.2 EPPM Web
Planning and Control Using Oracle Primavera P6 - Versions 8.2 & 8.3 EPPM Web
Planning and Control Using Oracle Primavera P6 - Version 8.1 & 8.2 Professional Client & Optional Client
Planning and Control Using Oracle Primavera P6 - Version 8.1, 8.2 & 8.3 Professional Client & Optional Client
Project Planning and Control Using Oracle Primavera P6 - Versions 8.1, 8.2 & 8.3 Professional Client & Optional Client
Planificación y Control de Proyectos Usando Oracle Primavera P6 - Versiones 8.1, 8.2 y 8.3 Cliente Profesional Opcional
项目规划和控制 ORACLE PRIMAVERA P6 应用 版本 8.1, 8.2 & 8.3 专业&可选客户端
Project Planning and Control Using Oracle Primavera P6 - Versions 8.1 to 8.4 Professional Client & Optional Client
Planning and Control Using Oracle Primavera P6 - Versions 8.2 to 8.4 EPPM Web
Planificación y Control de Proyectos Usando Oracle Primavera P6 Versiones 8.1 a 8.4 Cliente Profesional & Cliente Opcional
规划和控制 ORACLE® PRIMAVERA® P6 应用 版本 8.1-8.4 专业&可选客户端

This publication is only sold as a bound book and no parts may be reproduced by any means, electronic or print.

© Eastwood Harris Pty Ltd
## INTRODUCTION

1.1 Software Installation and Configuration
1.2 Purpose
1.3 Required Background Knowledge
1.4 Purpose of Planning
1.5 Project Planning Metrics
1.6 Planning Cycle
1.7 Levels of Planning
1.8 Monitoring and Controlling a Project

## CREATING A PROJECT PLAN

2.1 Understanding Planning and Scheduling Software
2.2 Enterprise Project Management
2.3 Understanding Your Project
2.4 Level 1 – Planning Without Resources
   2.4.1 Creating Projects
   2.4.2 Defining the Calendars
   2.4.3 Defining the Project Breakdown Structures
   2.4.4 Adding Activities
   2.4.5 Adding the Logic Links
   2.4.6 Developing a Closed Network
   2.4.7 Scheduling the Project
   2.4.8 Critical Path
   2.4.9 Total Float
   2.4.10 Free Float
   2.4.11 Relationship Colors
   2.4.12 Constraints Types
   2.4.13 Project Constraints
   2.4.14 Activity Constraints
   2.4.15 Risk Analysis
   2.4.16 Contingent Time
   2.4.17 Formatting the Display – Views and Filters
   2.4.18 Printing and Reports
   2.4.19 Issuing the Plan
2.5 Level 2 – Monitoring Progress Without Resources
   2.5.1 Setting the Baseline
   2.5.2 Tracking Progress
   2.5.3 Corrective Action
2.6 Level 3 – Scheduling With Resources and Roles
   2.6.1 Estimating or Planning for Control
   2.6.2 The Balance Between the Number of Activities and Resources
   2.6.3 Creating and Using Resources
   2.6.4 Creating and Using Roles
   2.6.5 The Relationship Between Resources and Roles
   2.6.6 Activity Type and Duration Type
   2.6.7 Budgets
   2.6.8 Resource Usage Profiles and Tables
   2.6.9 Resource Optimization
2.7 Level 4 – Monitoring and Controlling a Resourced Schedule
   2.7.1 Monitoring Projects with Resources
   2.7.2 Controlling a Project with Resources
## 3 STARTING UP AND NAVIGATION

### 3.1 Implementing Web Based Project Management Tools

### 3.2 Logging In

### 3.3 Primavera P6 Architecture

#### 3.3.1 Databases

#### 3.3.2 Web Tools

#### 3.3.3 Windows Client Server Tool

#### 3.3.4 Other Tools

### 3.4 P6 Web Functionality Areas and Interface

#### 3.4.1 Dashboards Tab

#### 3.4.2 Portfolios Tab

#### 3.4.3 Projects Tab

#### 3.4.4 Resources Tab

#### 3.4.5 Administer Tab

#### 3.4.6 Administer Menu, My Preferences

#### 3.4.7 Navigating Around P6 Web

#### 3.4.8 Bottom Pane Tabs

#### 3.4.9 Saving Data

### 3.5 Viewing Project Data – Projects Tab

#### 3.5.1 Projects, EPS Tab

#### 3.5.2 Projects Tab Menu and Activities Tab

#### 3.5.3 Opening a Project

#### 3.5.4 Viewing the OBS

#### 3.5.5 My Preferences – Date and Time Display

### 3.6 Understanding the Projects Window

#### 3.6.1 Activities Window

#### 3.6.2 Activities Window Menu

#### 3.6.3 Activity Toolbars

#### 3.6.4 Viewing the Hierarchy for Activity, Project, and Resource Codes

#### 3.6.5 Workspace

#### 3.6.6 Team Usage

#### 3.6.7 Issues

#### 3.6.8 Risks

#### 3.6.9 Documents

### 3.7 Right-clicking with the Mouse

### 3.8 Full Screen Mode Icon

### 3.9 Multiple Browser Windows and Tabs

### 3.10 Search Function

### 3.11 Accessing Help

### 3.12 Find and Replace Option

### 3.13 Closing a Project

### 3.14 Popup Windows

### 3.15 Closing Down

### 3.16 Workshop 1 – Navigating Around the Windows

## 4 CREATING A NEW PROJECT

### 4.1 Creating a Blank Project

### 4.2 Copy an Existing Project or EPS Node

### 4.3 Using the Project Templates Function

#### 4.3.1 Creating a New Project from a Template

#### 4.3.2 Creating a New Template

---

This publication is only sold as a bound book and no parts may be reproduced by any means, electronic or print.

© Eastwood Harris Pty Ltd
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.4</td>
<td>Importing a Project</td>
<td>54</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Primavera File Types</td>
<td>55</td>
</tr>
<tr>
<td>4.4.2</td>
<td>Non Primavera File Types</td>
<td>56</td>
</tr>
<tr>
<td>4.4.3</td>
<td>XML Import/Export Enhancements</td>
<td>56</td>
</tr>
<tr>
<td>4.4.4</td>
<td>UN/CEFACT XML Data Export</td>
<td>57</td>
</tr>
<tr>
<td>4.4.5</td>
<td>Granular Data Control During XML Import</td>
<td>57</td>
</tr>
<tr>
<td>4.5</td>
<td>Saving Project Information on Changing Windows</td>
<td>57</td>
</tr>
<tr>
<td>4.6</td>
<td>Deleting a Project</td>
<td>58</td>
</tr>
<tr>
<td>4.7</td>
<td>Setting Up a New Project</td>
<td>59</td>
</tr>
<tr>
<td>4.7.1</td>
<td>Project, EPS General Tab</td>
<td>59</td>
</tr>
<tr>
<td>4.7.2</td>
<td>Project Preferences Form</td>
<td>60</td>
</tr>
<tr>
<td>4.8</td>
<td>Saving Additional Project and EPS Information – Notebooks</td>
<td>61</td>
</tr>
<tr>
<td>4.10</td>
<td>Workshop 2 – Creating Your Project</td>
<td>63</td>
</tr>
<tr>
<td>5</td>
<td>DEFINING CALENDARS</td>
<td>65</td>
</tr>
<tr>
<td>5.1</td>
<td>Database Default Calendar</td>
<td>66</td>
</tr>
<tr>
<td>5.2</td>
<td>Accessing Global, Resource and Project Calendars</td>
<td>66</td>
</tr>
<tr>
<td>5.3</td>
<td>The Project Default Project Calendar</td>
<td>67</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Understanding the Project Default Project Calendar</td>
<td>67</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Assigning a Default Project Calendar</td>
<td>67</td>
</tr>
<tr>
<td>5.4</td>
<td>Creating a New Global Calendar</td>
<td>68</td>
</tr>
<tr>
<td>5.5</td>
<td>Creating a New Project Calendar</td>
<td>68</td>
</tr>
<tr>
<td>5.6</td>
<td>Shared Calendar</td>
<td>69</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Creating a New Shared Calendar</td>
<td>69</td>
</tr>
<tr>
<td>5.6.2</td>
<td>Creating New Personal Calendar</td>
<td>70</td>
</tr>
<tr>
<td>5.6.3</td>
<td>Personal and Shared Calendars Calculation and Display</td>
<td>71</td>
</tr>
<tr>
<td>5.7</td>
<td>Administer, My Calendar</td>
<td>71</td>
</tr>
<tr>
<td>5.8</td>
<td>Promote, Copy, Rename and Delete a Calendar</td>
<td>72</td>
</tr>
<tr>
<td>5.8.1</td>
<td>Promoting a Project Calendar to Global.</td>
<td>72</td>
</tr>
<tr>
<td>5.8.2</td>
<td>Copy a Calendar from One Project to Another</td>
<td>72</td>
</tr>
<tr>
<td>5.8.3</td>
<td>Renaming a Calendar</td>
<td>73</td>
</tr>
<tr>
<td>5.8.4</td>
<td>Deleting a Calendar</td>
<td>73</td>
</tr>
<tr>
<td>5.9</td>
<td>Base Calendars</td>
<td>74</td>
</tr>
<tr>
<td>5.9.1</td>
<td>Understanding Base Calendars</td>
<td>74</td>
</tr>
<tr>
<td>5.9.2</td>
<td>Remove a Base Calendar from a Calendar</td>
<td>74</td>
</tr>
<tr>
<td>5.10</td>
<td>Adjusting Calendar Working Hours</td>
<td>75</td>
</tr>
<tr>
<td>5.10.1</td>
<td>Editing Calendar Working Hours</td>
<td>75</td>
</tr>
<tr>
<td>5.10.2</td>
<td>Editing Selected Days Working Hours</td>
<td>77</td>
</tr>
<tr>
<td>5.10.3</td>
<td>Viewing the Calendar Working Hours</td>
<td>77</td>
</tr>
<tr>
<td>5.10.4</td>
<td>Calculation of Activity Durations in Days, Weeks or Months</td>
<td>78</td>
</tr>
<tr>
<td>5.11</td>
<td>Calendars for Calculating Project, WBS and Other Summary Durations</td>
<td>79</td>
</tr>
<tr>
<td>5.12</td>
<td>Tips for Mixed Calendar Schedules</td>
<td>80</td>
</tr>
<tr>
<td>5.13</td>
<td>Workshop 3 – Maintaining the Calendars</td>
<td>81</td>
</tr>
<tr>
<td>6</td>
<td>CREATING A PRIMAVERA PROJECT WBS</td>
<td>83</td>
</tr>
<tr>
<td>6.1</td>
<td>Viewing and Navigating the WBS</td>
<td>84</td>
</tr>
<tr>
<td>6.2</td>
<td>Creating and Deleting a WBS Node</td>
<td>85</td>
</tr>
<tr>
<td>6.3</td>
<td>WBS Node Separator</td>
<td>85</td>
</tr>
<tr>
<td>6.4</td>
<td>Activity Window Work Breakdown Structure Lower Pane Details</td>
<td>87</td>
</tr>
<tr>
<td>6.5</td>
<td>WBS Categories</td>
<td>88</td>
</tr>
<tr>
<td>6.6</td>
<td>Why a Primavera WBS is Important</td>
<td>89</td>
</tr>
<tr>
<td>6.7</td>
<td>Workshop 4 – Creating the Work Breakdown Structure</td>
<td>91</td>
</tr>
</tbody>
</table>
### 7 ADDING ACTIVITIES AND ORGANIZING UNDER THE WBS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1 New Activity Defaults</td>
<td>94</td>
</tr>
<tr>
<td>7.1.1 Duration Type</td>
<td>94</td>
</tr>
<tr>
<td>7.1.2 Percent Complete Type</td>
<td>94</td>
</tr>
<tr>
<td>7.1.3 Activity Types and Milestones</td>
<td>97</td>
</tr>
<tr>
<td>7.1.4 Cost Account</td>
<td>98</td>
</tr>
<tr>
<td>7.1.5 Calendar</td>
<td>98</td>
</tr>
<tr>
<td>7.1.6 Price/Unit</td>
<td>98</td>
</tr>
<tr>
<td>7.1.7 Auto-numbering Defaults</td>
<td>99</td>
</tr>
<tr>
<td>7.2 Adding New Activities</td>
<td>99</td>
</tr>
<tr>
<td>7.3 Default Activity Duration</td>
<td>99</td>
</tr>
<tr>
<td>7.4 Copying Activities from other Programs</td>
<td>99</td>
</tr>
<tr>
<td>7.5 Copying Activities in P6</td>
<td>100</td>
</tr>
<tr>
<td>7.6 Elapsed Durations</td>
<td>101</td>
</tr>
<tr>
<td>7.7 Finding the Bars in the Gantt Chart</td>
<td>101</td>
</tr>
<tr>
<td>7.8 Activity Window – Bottom Pane</td>
<td>101</td>
</tr>
<tr>
<td>7.9 Discussion Feature</td>
<td>103</td>
</tr>
<tr>
<td>7.10 Assigning Calendars to Activities</td>
<td>104</td>
</tr>
<tr>
<td>7.11 Assigning Activities to a WBS Node</td>
<td>104</td>
</tr>
<tr>
<td>7.12 Reordering or Sorting Activities</td>
<td>105</td>
</tr>
<tr>
<td>7.13 Undo</td>
<td>106</td>
</tr>
<tr>
<td>7.14 Summarizing Activities Using WBS</td>
<td>107</td>
</tr>
<tr>
<td>7.15 Spell Check</td>
<td>107</td>
</tr>
<tr>
<td>7.16 Workshop 5 – Adding Activities</td>
<td>109</td>
</tr>
</tbody>
</table>

### 8 FORMATTING THE ACTIVITY WINDOW AND VIEWS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 Formatting the Projects Activity Window</td>
<td>111</td>
</tr>
<tr>
<td>8.2 Views</td>
<td>112</td>
</tr>
<tr>
<td>8.2.1 Understanding Views</td>
<td>112</td>
</tr>
<tr>
<td>8.2.2 Opening a View</td>
<td>112</td>
</tr>
<tr>
<td>8.2.3 Create a View</td>
<td>113</td>
</tr>
<tr>
<td>8.3 Columns and Activity Sort Order</td>
<td>114</td>
</tr>
<tr>
<td>8.3.1 Selecting the Columns to be Displayed</td>
<td>114</td>
</tr>
<tr>
<td>8.3.2 Setting the Order of the Columns from Left to Right on the Screen</td>
<td>115</td>
</tr>
<tr>
<td>8.3.3 Adjusting the Width of Columns</td>
<td>115</td>
</tr>
<tr>
<td>8.3.4 First Column Data Display</td>
<td>115</td>
</tr>
<tr>
<td>8.3.5 Renaming Columns</td>
<td>116</td>
</tr>
<tr>
<td>8.3.6 Activity Sort Order</td>
<td>116</td>
</tr>
<tr>
<td>8.4 Grouping</td>
<td>117</td>
</tr>
<tr>
<td>8.5 Filters</td>
<td>119</td>
</tr>
<tr>
<td>8.5.1 Understanding Filters</td>
<td>119</td>
</tr>
<tr>
<td>8.5.2 Applying a Filter</td>
<td>120</td>
</tr>
<tr>
<td>8.5.3 Removing a filter</td>
<td>121</td>
</tr>
<tr>
<td>8.5.4 Creating a Filter</td>
<td>122</td>
</tr>
<tr>
<td>8.5.5 One Parameter Filter</td>
<td>122</td>
</tr>
<tr>
<td>8.5.6 Two Parameter Filter</td>
<td>123</td>
</tr>
<tr>
<td>8.6 Improved Filtering</td>
<td>123</td>
</tr>
<tr>
<td>8.7 Project ID Filtering Option for Creating Portfolios</td>
<td>124</td>
</tr>
<tr>
<td>8.8 Bars</td>
<td>125</td>
</tr>
<tr>
<td>8.9 Gantt Chart – Timescale</td>
<td>126</td>
</tr>
<tr>
<td>8.9.1 Customize Activity View form – Gantt Chart tab</td>
<td>126</td>
</tr>
<tr>
<td>8.9.2 Right-click in Timescale Options</td>
<td>126</td>
</tr>
<tr>
<td>8.9.3 Zoom to fit Icon</td>
<td>127</td>
</tr>
<tr>
<td>8.9.4 Dragging the Timescale</td>
<td>127</td>
</tr>
<tr>
<td>Chapter</td>
<td>Section</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>8.10</td>
<td>Activity Network</td>
</tr>
<tr>
<td>8.11</td>
<td>Table View</td>
</tr>
<tr>
<td>8.12</td>
<td>Calendar View</td>
</tr>
<tr>
<td>8.13</td>
<td>Access – Sharing Views with Other Users</td>
</tr>
<tr>
<td>8.14</td>
<td>Workshop 6 – Formatting the Bar Chart</td>
</tr>
<tr>
<td>9</td>
<td>ADDING RELATIONSHIPS</td>
</tr>
<tr>
<td>9.1</td>
<td>Constraints</td>
</tr>
<tr>
<td>9.2</td>
<td>Understanding Relationships</td>
</tr>
<tr>
<td>9.3</td>
<td>Understanding Lags and Leads</td>
</tr>
<tr>
<td>9.4</td>
<td>Understanding the Lag Calendar</td>
</tr>
<tr>
<td>9.5</td>
<td>Formatting the Relationships</td>
</tr>
<tr>
<td>9.6</td>
<td>Adding or Removing Relationships</td>
</tr>
<tr>
<td>9.6.1</td>
<td>Graphically Adding and Deleting a Relationship</td>
</tr>
<tr>
<td>9.6.2</td>
<td>Adding, Deleting and Editing Relationships with the Activity Details Form</td>
</tr>
<tr>
<td>9.6.3</td>
<td>Adding and Deleting Relationships Using Columns</td>
</tr>
<tr>
<td>9.6.4</td>
<td>Chain Linking</td>
</tr>
<tr>
<td>9.7</td>
<td>Dissolving Activities</td>
</tr>
<tr>
<td>9.8</td>
<td>Circular Relationships</td>
</tr>
<tr>
<td>9.9</td>
<td>Relationships Detail Window on the Activities Page</td>
</tr>
<tr>
<td>9.10</td>
<td>Scheduling the Project</td>
</tr>
<tr>
<td>9.11</td>
<td>Workshop 7 – Adding the Relationships</td>
</tr>
<tr>
<td>10</td>
<td>ACTIVITY NETWORK VIEW</td>
</tr>
<tr>
<td>10.1</td>
<td>Introduction to the Activity Network View</td>
</tr>
<tr>
<td>10.2</td>
<td>Early Date, Late Date and Float Calculations</td>
</tr>
<tr>
<td>10.3</td>
<td>Workshop 8 – Scheduling Calculations and Activity Network View</td>
</tr>
<tr>
<td>11</td>
<td>CONSTRAINTS</td>
</tr>
<tr>
<td>11.1</td>
<td>Assigning Constraints</td>
</tr>
<tr>
<td>11.1.1</td>
<td>Number of Constraints per Activity</td>
</tr>
<tr>
<td>11.1.2</td>
<td>Setting a Primary Constraint Using the Activity Details Form</td>
</tr>
<tr>
<td>11.1.3</td>
<td>Setting a Secondary Constraint Using the Activity Details Form</td>
</tr>
<tr>
<td>11.1.4</td>
<td>Expected Finish Constraint</td>
</tr>
<tr>
<td>11.1.5</td>
<td>Setting Constraints Using Columns</td>
</tr>
<tr>
<td>11.1.6</td>
<td>Setting Constraints by Dragging an Activity</td>
</tr>
<tr>
<td>11.2</td>
<td>Project Must Finish By Date</td>
</tr>
<tr>
<td>11.3</td>
<td>Activity Notebooks</td>
</tr>
<tr>
<td>11.3.1</td>
<td>Creating Notebook Topics</td>
</tr>
<tr>
<td>11.3.2</td>
<td>Adding Notes</td>
</tr>
<tr>
<td>11.4</td>
<td>Workshop 9 – Constraints</td>
</tr>
<tr>
<td>12</td>
<td>PRINTING AND REPORTS</td>
</tr>
<tr>
<td>12.1</td>
<td>Printing the Gantt Chart</td>
</tr>
<tr>
<td>12.2</td>
<td>Print Preview</td>
</tr>
<tr>
<td>12.3</td>
<td>Page Setup</td>
</tr>
<tr>
<td>12.3.1</td>
<td>Page Layout Tab</td>
</tr>
<tr>
<td>12.3.2</td>
<td>Header and Footer Tabs</td>
</tr>
<tr>
<td>12.3.3</td>
<td>Custom Header and Custom Footer Tabs</td>
</tr>
<tr>
<td>12.3.4</td>
<td>Sheet Tab</td>
</tr>
<tr>
<td>12.4</td>
<td>Enhanced Printing from the EPS and Activities Windows</td>
</tr>
<tr>
<td>12.5</td>
<td>Reports</td>
</tr>
<tr>
<td>12.6</td>
<td>Other Primavera Reporting Options</td>
</tr>
<tr>
<td>12.7</td>
<td>Workshop 10 – Printing</td>
</tr>
</tbody>
</table>
13  SCHEDULING OPTIONS AND SETTING A BASELINE  175

13.1  Understanding Date Fields  176
13.1.1  Early Start and Early Finish  176
13.1.2  Late Start and Late Finish  176
13.1.3  Actual Start and Finish  177
13.1.4  Start and Finish  177
13.1.5  Planned Start and Finish  177
13.1.6  Planned Dates Issues  178
13.1.7  Remaining Early Start and Finish  179
13.1.8  Remaining Late Start and Finish  180

13.2  Scheduling Options – General Tab  180
13.2.1  Ignore relationships to and from other projects (& Ignore External Dates)  181
13.2.2  Make open-ended activities critical  182
13.2.3  Use Expected Finish Dates  183
13.2.4  Schedule automatically when a change affects dates – Not in the Web Client  183
13.2.5  Level resources during scheduling  183
13.2.6  Recalculate assignment costs after scheduling  184
13.2.7  When scheduling progressed activities use  184
13.2.8  Calculate start-to-start lag from  187
13.2.9  Define critical activities as  187
13.2.10  Calculate float based on finish date  188
13.2.11  Compute Total Floats  189
13.2.12  Calendar for scheduling Relationship Lag  190
13.2.13  Scheduling Options – Advanced Tab  190

13.3  Setting the Baseline  191
13.3.1  Creating a Baseline  192
13.3.2  Deleting a Baseline  192
13.3.3  Restoring a Baseline to the Database as an Active Project  192
13.3.4  Update Baselines  193
13.3.5  Copying a Project with Baselines  193
13.3.6  Setting the Baseline Project  194
13.3.7  Understanding the <Current Project> Baseline  195
13.3.8  Displaying the Baseline Data  197

13.4  Additional Baseline Fields  198
13.5  Workshop 11 – WBS, LOEs and Setting the Baseline  201

14  UPDATING AN UNRESOURCED SCHEDULE  205

14.1  Practical Methods of Recording Progress  206
14.2  Understanding the Concepts  207
14.2.1  Activity Lifecycle  207
14.2.2  Assigning an Actual Start Date and Time of an Activity  207
14.2.3  Assigning an Actual Finish Date and Time of an Activity  208
14.2.4  Calculation of Durations of an In-Progress Activity  208
14.2.5  Summary Bars Progress Calculation  210
14.2.6  Understanding the Data Date  210

14.3  Updating the Schedule  211
14.3.1  Updating Activities Using the General Tab of the Details Form  211
14.3.2  Updating Activities Using Columns  212
14.4  Progress Spotlight  212
14.5  Suspend and Resume  212
14.6  Scheduling the Project  213
14.7  Update Project  213
14.8  Comparing Progress with Baseline  213
14.9  Progress Line Display on the Gantt Chart  214

© Eastwood Harris Pty Ltd
14.10 Corrective Action 215
14.11 Check List for Updating a Schedule 215
14.12 Workshop 12 – Progressing and Baseline Comparison 217

15 ADMINISTER MENU 221
15.1 Administer Menu 221
15.2 My Calendar 222
15.3 My Preferences 222
15.3.1 Global, General Tab 222
15.3.2 Global, General, Time Units Format Tab 223
15.3.3 Global, Resources Tab, Resource Staffing 223
15.3.4 Global, Resources Tab, Resource Assignments 224
15.3.5 Global, Project Score Tab 225
15.3.6 Global, Performance Threshold Tab 225
15.3.7 Global, Currency Tab 226
15.3.8 Global, Date Format Tab 226
15.3.9 Global, Issues Tab 227
15.3.10 View Tab 227
15.3.11 Setting a Default Start Page 227
15.3.12 Password Tab 228
15.4 Application Settings 229
15.4.1 Data Limits 229
15.4.2 Earned Value 229
15.4.3 General 230
15.4.4 ID Lengths 230
15.4.5 Services 230
15.4.6 Timesheets 230
15.4.7 Time Periods 230
15.5 Enterprise Data 231
15.5.1 Understanding UDFs and Activity Codes 231
15.5.2 Currencies 233
15.5.3 Financial Periods 233
15.5.4 Global Calendars 234
15.5.5 Locations 234
15.5.6 Overhead Codes 234
15.5.7 Timesheet Periods 234
15.5.8 Projects 235
15.5.9 Activities 235
15.5.10 Resources 237
15.5.11 Risks 238
15.5.12 Issues 239
15.5.13 Documents 239
15.6 Global Schedule Services 240
15.7 User Access 240
15.7.1 Users 240
15.7.2 OBS 241
15.7.3 Global Security Profiles 241
15.7.4 Project Security Profiles 242
15.7.5 Copy User Views when Copying a User 243
15.8 User Sessions 244
15.9 Miscellaneous Defaults 244
15.9.1 Default Project 244
# CREATING ROLES AND RESOURCES

16.1 Understanding Resources and Roles

16.1.1 Individual Resources

16.1.2 Group Resources

16.1.3 Input and Output Resources

16.1.4 Understanding Roles

16.1.5 Understanding Resource Teams and Role Teams

16.2 Creating Roles

16.2.1 Description Tab

16.2.2 Resources Tab

16.2.3 Prices Tab

16.2.4 Limits Tab

16.2.5 Role Teams Tab

16.3 Creating Resources and the Resources Window

16.3.1 Resources General Tab

16.3.2 Resource Team Tab

16.3.3 Resources Roles Tab

16.3.4 Resources Codes Tab

16.3.5 Resources Units and Prices Tab

16.3.6 Resources Settings Tab

16.3.7 Notes Tab

16.4 Workshop 13 – Adding Resources to the Database

# ASSIGNING ROLES, RESOURCES AND EXPENSES

17.1 Understanding Resources

17.2 Understanding Resource Calculations and Terminology

17.3 Project Preferences Form, Resource Defaults

17.3.1 Rate Type

17.3.2 Resources can be assigned to the same activity more than once

17.3.3 Understanding Resource Option to Drive Activity Dates By Default

17.3.4 Price/Unit

17.3.5 Activity Type

17.3.6 Duration Type

17.4 My Preferences Applicable to Assigning Resources

17.4.1 Units/Time Format

17.4.2 Resource Assignments

17.4.3 Resource Assignments

17.5 Activities Window Resource Information

17.5.1 Details General Form

17.6 Assigning and Removing Roles

17.7 Assigning and Removing Resources

17.7.1 Assigning a Resource to an Assigned Role

17.7.2 Assigning a Resource to an Activity Without a Role

17.7.3 Removing a Resource or Role

17.7.4 Assigning a Resource to an Activity More Than Once

17.7.5 Selecting Multiple Items in Assign Dialog Forms

17.8 Request Resources

17.9 Resource and Activity Duration Calculation and Resource Lags

17.9.1 Activity Duration

17.9.2 Resource Lag – Windows Client Only

17.10 Resource, Planning Window

17.11 Expenses

17.12.1 Editing the Resource Usage Spreadsheet – Bucket Planning

17.13 Suggested Setup for Creating a Resourced Schedule
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.14</td>
<td>Workshop 14 – Assigning Resources and Expenses to Activities</td>
<td>285</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>RESOURCE OPTIMIZATION</td>
<td>289</td>
<td></td>
</tr>
<tr>
<td>18.1</td>
<td>Reviewing Resource Loading</td>
<td>289</td>
<td></td>
</tr>
<tr>
<td>18.2</td>
<td>Assignments View</td>
<td>289</td>
<td></td>
</tr>
<tr>
<td>18.3</td>
<td>Resources, Analysis, Role Usage Window</td>
<td>292</td>
<td></td>
</tr>
<tr>
<td>18.3.1</td>
<td>Resources, Analysis, Resource Usage Window</td>
<td>293</td>
<td></td>
</tr>
<tr>
<td>18.3.2</td>
<td>Resources, Analysis, Resource Analysis Window</td>
<td>294</td>
<td></td>
</tr>
<tr>
<td>18.4</td>
<td>Methods of Resolving Resource Peaks and Conflicts</td>
<td>295</td>
<td></td>
</tr>
<tr>
<td>18.5</td>
<td>Workshop 15 – Resources Optimization</td>
<td>297</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>UPDATING A RESOURCED SCHEDULE</td>
<td>301</td>
<td></td>
</tr>
<tr>
<td>19.1</td>
<td>Understanding Planned Values and Baseline Projects</td>
<td>302</td>
<td></td>
</tr>
<tr>
<td>19.1.1</td>
<td>Cost and Units Planned Values</td>
<td>302</td>
<td></td>
</tr>
<tr>
<td>19.1.2</td>
<td>Baseline Project and Values</td>
<td>302</td>
<td></td>
</tr>
<tr>
<td>19.2</td>
<td>Understanding the Current Data Date</td>
<td>303</td>
<td></td>
</tr>
<tr>
<td>19.3</td>
<td>Information Required to Update a Resourced Schedule</td>
<td>303</td>
<td></td>
</tr>
<tr>
<td>19.4</td>
<td>Project Preferences Defaults for Updating a Resourced Schedule</td>
<td>305</td>
<td></td>
</tr>
<tr>
<td>19.4.1</td>
<td>Project Preferences Calculations Tab</td>
<td>305</td>
<td></td>
</tr>
<tr>
<td>19.4.2</td>
<td>Project Preferences Defaults Tab</td>
<td>306</td>
<td></td>
</tr>
<tr>
<td>19.5</td>
<td>Activities Window – Percent Complete Types</td>
<td>307</td>
<td></td>
</tr>
<tr>
<td>19.5.1</td>
<td>Assigning the Project Default Percent Complete Type</td>
<td>307</td>
<td></td>
</tr>
<tr>
<td>19.5.2</td>
<td>Physical Percent Complete Type</td>
<td>308</td>
<td></td>
</tr>
<tr>
<td>19.5.3</td>
<td>Duration Percent Complete Type</td>
<td>309</td>
<td></td>
</tr>
<tr>
<td>19.5.4</td>
<td>Units Percent Complete Type</td>
<td>309</td>
<td></td>
</tr>
<tr>
<td>19.6</td>
<td>Using Steps to Calculate Activity Percent Complete</td>
<td>310</td>
<td></td>
</tr>
<tr>
<td>19.7</td>
<td>Updating the Schedule</td>
<td>311</td>
<td></td>
</tr>
<tr>
<td>19.7.1</td>
<td>Preferences, Defaults and Options for Updating a Project</td>
<td>311</td>
<td></td>
</tr>
<tr>
<td>19.7.2</td>
<td>Updating Dates and Percent Complete</td>
<td>313</td>
<td></td>
</tr>
<tr>
<td>19.8</td>
<td>Updating Resources</td>
<td>313</td>
<td></td>
</tr>
<tr>
<td>19.8.1</td>
<td>Assignments Tab</td>
<td>313</td>
<td></td>
</tr>
<tr>
<td>19.8.2</td>
<td>General Tab</td>
<td>313</td>
<td></td>
</tr>
<tr>
<td>19.8.3</td>
<td>Applying Actuals</td>
<td>314</td>
<td></td>
</tr>
<tr>
<td>19.9</td>
<td>Updating Expenses</td>
<td>315</td>
<td></td>
</tr>
<tr>
<td>19.10</td>
<td>Updating Using Progress Reporter</td>
<td>316</td>
<td></td>
</tr>
<tr>
<td>19.11</td>
<td>Workshop 16 – Updating a Resourced Schedule</td>
<td>317</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>OTHER METHODS OF ORGANIZING PROJECT DATA</td>
<td>321</td>
<td></td>
</tr>
<tr>
<td>20.1</td>
<td>Understanding Project Breakdown Structures</td>
<td>321</td>
<td></td>
</tr>
<tr>
<td>20.2</td>
<td>Activity Codes</td>
<td>322</td>
<td></td>
</tr>
<tr>
<td>20.2.1</td>
<td>Understanding Activity Codes</td>
<td>322</td>
<td></td>
</tr>
<tr>
<td>20.2.2</td>
<td>Activity Code Creation</td>
<td>323</td>
<td></td>
</tr>
<tr>
<td>20.2.3</td>
<td>Defining Activity Code Values, Descriptions and Colors</td>
<td>323</td>
<td></td>
</tr>
<tr>
<td>20.2.4</td>
<td>Assigning Activity Code Values to Activities</td>
<td>324</td>
<td></td>
</tr>
<tr>
<td>20.2.5</td>
<td>Add Activity Codes When Assigning Codes</td>
<td>324</td>
<td></td>
</tr>
<tr>
<td>20.2.6</td>
<td>Grouping, Sorting and Filtering with Activity Codes</td>
<td>325</td>
<td></td>
</tr>
<tr>
<td>20.2.7</td>
<td>Importing Activity Codes with Excel</td>
<td>325</td>
<td></td>
</tr>
<tr>
<td>20.3</td>
<td>User Defined Fields</td>
<td>326</td>
<td></td>
</tr>
<tr>
<td>20.4</td>
<td>Workshop 17 – Activity Codes and User Defined Fields (UDF)</td>
<td>329</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>INDEX</td>
<td>333</td>
<td></td>
</tr>
</tbody>
</table>
8 FORMATTING THE ACTIVITY WINDOW AND VIEWS

8.1 Formatting the Projects Activity Window

There are a number of tool bar icons that may be used to format the screen and operate the software. Some of the icons used to operate the software and format the top pane of the Activities View are listed below:

<table>
<thead>
<tr>
<th>Icon/s</th>
<th>Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save</td>
<td>Commits any change to data to the database.</td>
</tr>
<tr>
<td></td>
<td>Cancel</td>
<td>Reverses any unsaved changes not committed to the database. This could be considered a type of undo.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes selected item.</td>
</tr>
<tr>
<td></td>
<td>Schedule</td>
<td>Recalculates the schedule.</td>
</tr>
<tr>
<td></td>
<td>Find</td>
<td>Finds data in columns.</td>
</tr>
<tr>
<td></td>
<td>Columns</td>
<td>Opens the Customize Columns form to format columns.</td>
</tr>
<tr>
<td></td>
<td>Grouping</td>
<td>Opens the Customize Grouping form to Group activities under bands.</td>
</tr>
<tr>
<td></td>
<td>Filters</td>
<td>Options to create, apply and edit filters.</td>
</tr>
<tr>
<td></td>
<td>Customize Gantt</td>
<td>Opens the Customize Gantt Chart Options form with options to format bars and the Gantt Chart.</td>
</tr>
<tr>
<td></td>
<td>Chart Options</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Progress Spotlight</td>
<td>Used to move the Progress Spotlight line forward And backwards one timescale period.</td>
</tr>
<tr>
<td></td>
<td>Show/Hide Relationship lines</td>
<td>This toggles between showing and hiding the relationship lines.</td>
</tr>
<tr>
<td></td>
<td>Show/Hide Progress lines</td>
<td>Used to show or hide the progress lines.</td>
</tr>
<tr>
<td></td>
<td>Expand All and Collapse All</td>
<td>Used to expand all WBS Nodes and show all activities and to collapse all WBS Nodes and show only a project summary bar.</td>
</tr>
<tr>
<td></td>
<td>Zoom to Fit</td>
<td>Zooms the timescale to fit the available screen for the timescale.</td>
</tr>
<tr>
<td></td>
<td>Full Screen Mode and Normal Mode</td>
<td>Switching to Full Screen Mode and hides all the internet explorer toolbars etc. allowing more working space on the screen.</td>
</tr>
<tr>
<td></td>
<td>Gantt Chart</td>
<td>Displays the activity Table and Gantt Chart bars.</td>
</tr>
<tr>
<td></td>
<td>Table</td>
<td>Displays the activity Table ONLY.</td>
</tr>
<tr>
<td></td>
<td>Activity Network</td>
<td>Displays the Activity Network view.</td>
</tr>
<tr>
<td></td>
<td>Calendar</td>
<td>Displays the Calendar view.</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>Create, edit and delete Views.</td>
</tr>
<tr>
<td></td>
<td>Apply a View</td>
<td>Apply and existing View buttons are found on the View Menu.</td>
</tr>
</tbody>
</table>
8.2 Views

8.2.1 Understanding Views

A View is a function in which the formatting of parameters such as the Columns, Grouping, activities, Filters and Bars is saved and reapplied later. This function is similar to Layouts in P3, P6 Windows Client and SureTrak or Views in Asta Powerproject and Microsoft Project.

- A View is assigned a name and may be edited, saved or reapplied at a later date.
- Views have the Filter function incorporated into the function which is different to most other products.
- A View may be created and saved by one user and may be made available to a number of other users.

Views and Filters created in the Windows Client are not accessible in the Web and may not be imported into the Web.

8.2.2 Opening a View

To open a view:

- Click on the Apply a View icon on the Project, Activity Window, View toolbar, which is usually by default on the right hand side, and this will reveal a list of available views,

Select the view from the list,

If you have made edits to the current view you will be asked if you wish to save the changes when moving to another part of the software.

Views with a tow blue overlapping squares are organized by WBS and allow adding, deleting and editing the WBS structure.
8.2.3 Create a View

To create a new View you will need to copy and existing View and edit it:

- Ensure you have a project open and are in the Projects Window Activities tab,
- Apply an appropriate view to copy using the Apply a View icon,
- Click on the View icon to open a menu,
- Save View saves any changes to a View.
  NOTE: When a View is not saved then the next time it is applied all edits made to the View are not saved.
- Save View As icon is used to save and rename a View that may then be edited.
- Delete View icon permanently deletes the current View.
- E-mail View allows a view to be emailed to another person if your server has been configured,
- Select the Customize icon to open the Customize Activity View form,
- Therefore to create a new View:
  ➢ Select Save View As is to save your new View, then
  ➢ Select the Customize icon to open the Customize Activity View form to edit your View:
  - The Customize form may be resized by dragging the edges.
  - Do not forget to save any changes after you have applied any changes.
8.3 Columns and Activity Sort Order

The columns tab allows the selection and horizontal ordering of the columns and sorting of the activities within bands.

The columns may be edited using either:

- The Columns form by clicking on the icon, or
- Customize View form.

Both forms operate in the same way.

The Activity Name is usually displayed in the far left column and the Activity ID as the second column otherwise the names in the bands such as the Project Name, WBS name are truncated so they are unreadable, as per the picture below:

<table>
<thead>
<tr>
<th>WBS / Activity</th>
<th>Activity Name</th>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Bid for F...</td>
<td>02-Dec-13 08</td>
<td></td>
</tr>
<tr>
<td>☑ Technical...</td>
<td>02-Dec-13 08</td>
<td></td>
</tr>
<tr>
<td>☑ OZ1 000</td>
<td>Approval to Bid</td>
<td>02-Dec-13 08</td>
</tr>
<tr>
<td>☑ OZ1 010</td>
<td>Determine Installation</td>
<td>02-Dec-13 08</td>
</tr>
</tbody>
</table>

8.3.1 Selecting the Columns to be Displayed

The available columns are displayed in the right window and may be listed under Categories and each category may be opened by clicking on the + or - icons.

The columns to be displayed are listed in the right Selected Columns window and are copied from the Available Columns to and from Selected Columns using the and icons.

Version 8.4 now allows you to select the position of the new column before adding the column.
8.3.2 Setting the Order of the Columns from Left to Right on the Screen

The order of the columns on the screen, from left to right, is the same as the order in the Customize Activity View form Selected Columns window from top to bottom.

The order of the columns may be altered:

- Highlight the column in the Columns form Selected Options window and use the ▲ and ▼ icons, or
- Close the form and Left-click on the column title in the Projects, Activities Window and drag the column.

8.3.3 Adjusting the Width of Columns

You may adjust the width of the column by dragging the column title separator in the Projects, Activities Window:

- Move the mouse pointer to the right hand side of the header title and
- A ± icon will then appear and enable the column to be adjusted by Left-clicking and dragging.

8.3.4 First Column Data Display

The first column may display the Activity ID or Activity Name and this option is set in:

- The Customize View form Columns tab or the
- Columns form.

When the Show first column as is set to Activity ID then the WBS Description may be truncated.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Planned Duration</th>
<th>Start Date</th>
<th>Finish Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building 1</td>
<td>1,039d</td>
<td>01-Sep-10 08 A</td>
<td>24-Sep-11 10</td>
</tr>
</tbody>
</table>

You may find it better to display the Activity Name as the Show first column as and Activity ID as the first Selected Column:
8.3.5 Renaming Columns

P6 R8.3 allows users to rename columns on the Activities page.

To rename a column:
- In the Activities page, Right-click on a column header and select Rename Column to open the Rename Column form;
- To rename the column’s Default Name, type the new name in the box provided next to New Name;
- Click Ok to confirm changes.

8.3.6 Activity Sort Order

The activity sort order is set by:
- Using the Sort by and Sort Order options in the Columns form, or
- Clicking in the column title. The sort order is indicated by an arrow in the column title header and users of the P6 Windows Client will notice that these arrows are in the reverse direction of the P6 Windows Client.

Clicking in the column header will destroy any sort order set up in the Columns tab. So if you have a very specific sort order defined in a View then you should save the view as soon as possible in case you click in the header in error.
8.4 Grouping
The Grouping activities under the bands may be edited using either:

- The Grouping form by clicking on the Grouping icon, or
- Customize View form.

Both forms operate in the same way.

Grouping enables activities in the Project, Activity Window to be sorted and organized under other parameters such as WBS, Total Float and. This function is similar to Group and Sort in the Windows Client, Organize in P3 and SureTrak and Grouping in Microsoft Project and Asta Powerproject.

The Grouping form has several options:

Field, Level and To Level

When a hierarchical code such as a WBS and the To Level of All is selected, then the subsequent bands for Level 2, Level 3 etc. are completed by the software and there are no other banding options available and the WBS is displayed hierarchically.
When a hierarchical code such as a **WBS** is selected and the **To Level** is assigned a value then all the subsequent bands are **NOT** completed by the software and other bands may be selected:

**Band, Color and Text Color**

- These options are used to format the text of the bands:

**Sort Order**

Each band may be sorted using the **Sort Order**, which operates on:

- The ID/Code when Hierarchy is selected and
- Name/Description when Ascending or Descending is selected.

**Hierarchy** should normally be selected but the **Name/Description** allows another sort order for the WBS.

**Band Options**

These option control the display of Band titles, summary information associated with bands and when a band has no activities it may be hidden.
The picture below shows the effect with all the options unchecked:

And checked:

8.5  Filters
This section covers the ability of Primavera to control which activities are displayed, both on the screen and in printouts, by using Filters.

8.5.1  Understanding Filters
Primavera has an ability to display activities that meet specific criteria. You may want to see only the incomplete Activities, or the work scheduled for the next couple of months or weeks, or the Activities that are in-progress.

- P6 Windows Client filters are not available in P6 Web.
- Primavera defaults to displaying all activities. There are a number of pre-defined filters available that you may use or edit. You may also create one or more of your own.

A filter may be applied to display, but NOT to highlight as in other products, those activities that meet a criteria.
There are the following types of filters:

- **Standard Filters** which are supplied with the system and may not be edited or deleted.
- **Global** which are managed by the administrator and may be applied by any user to any project.
- **Multiple User** available to more than one user.
- **User** filters which are edited as required.

There are a large number of options available to create a filter and from the following examples you should be able to experiment and add your own filters.

You might consider placing the project name or number at the start of a Filter name so you may identify which Filter belongs to which projects. Databases with a large number of Global Filters become difficult to manage.

The following types of filters are not available:

- Drop down or Auto filters as in Excel and Microsoft Project.
- Interactive filters as available in SureTrak and Microsoft Project. This is when a filter is applied and the user is offered choices from drop down list. The lack of this function may result in an excessive quantity of filters being generated or the user continually editing frequently used filters.
- Project filters, which would only be available when a project is opened.

### 8.5.2 Applying a Filter

To apply an existing single filter:

- Click on the **Filter** icon, or
- Select **Filters…** from the **View** menu to open the **Customize Filters** form:

  - Check the filter you wish to apply and
    - Select **Apply** to apply the filter and leave the **Customize Filters** form open and
    - Select **OK** to apply the filter and close the **Customize Filters** form.
To apply multiple filters:

- Click on the Filter icon,
- Select Filters… icon from the View menu to open the Customize Filters form,
- Check two or more filters, and
- Select from Show matches for if you wish to select:
  - all applied filters that will normally result in fewer activities, or
  - any applied filters that will normally result in more activities being displayed.

Then:

- Select to apply the filter and leave the Customize Filters form open and
- Select to apply the filter and close the Customize Filters form.

8.5.3 Removing a filter

To remove a filter:

- Open the Customize Filters form and uncheck all the check boxes, or
- Click on the Clear icon, or
- Selecting the Clear Filters icon on the Filters menu:
8.5.4 Creating a Filter
To create a new filter:

- Click on the **Filter** icon, and either
  - Select **Filters**… from the **View** menu to open the **Create Filters** form and click on the **Add New Filter**…. icon to open the **Create Filter** form, or
  - Click on the **Add New Filter**…. Icon to open the **Create Filter** form:

- You are now ready to add the filter name and create the new filter and populate the fields:

![Create Filter Form]

- Click on the Access tab to decide to who may access and assign the filter:

![Access Tab]

8.5.5 One Parameter Filter
The following example is a filter to display activities with Total Float that is less or equal to 2 days:

![One Parameter Filter Example]

*This book is only sold as a bound book and no parts may be reproduced by any means, electronic or print.*

© Eastwood Harris Pty Ltd
8.5.6 Two Parameter Filter
The following example is a filter to display critical activities that start after 1 Jan 2014:

- The drop down box under by Match has two options:
  - Match all of the following rules. This is used when an activity must meet all of the selected parameters.
  - Match any of the following rules. This is used when an activity must meet any of the selected parameters.
- If the Select Filter Criteria of Match all of the following rules was select and then ONLY Critical Activities starting after 1 Jan 14 and all Critical activities would be displayed.
- If the Select Filter Criteria of Match all of the following rules was selected then all Critical Activities and all activities starting after 1 Jan 14 would be displayed.

8.6 Improved Filtering
P6 R8.3 has introduced new fields to filter data under additional criteria in the EPS, Activities, and Resource Assignments windows:
- Last Modified Date
- Last Modified By
- At Completion Labor Units
- At Completion Non Labor Units
- Feedback from Resource (Activities Window)
- Review Finish Date (Activities Window)
To use these new filters:

- Go to the Activities or EPS window in the Projects section, or to the Assignments page in the Resources section;
- Select View, Filter, Add New Filter or click on the Filter button located in the toolbar and then click on the Add New Filter to open the Create Filter form;
- From the dropdown menu, define the filter you wish to apply and then click Ok to confirm and close the form.

8.7 Project ID Filtering Option for Creating Portfolios

When creating a filtered portfolio, it is possible to use the Project ID as the parameter for filtering in P6 R8.3. If Project ID is selected then the available conditional terms are the following:

- equals,
- is not equal to,
- contains,
- does not contain,
- starts with,
- ends with,
To use this option:
- Open the Portfolios menu and select Manage Portfolios,
- Click on Create Project Portfolio,
- Enter a desired name and select the **By Filter** from the Manage this Portfolio options,
- Select **Project ID** from the dropdown menu on the Parameter list.

8.8 Bars

The options for formatting the bars is self-explanatory and are edited from the Customize Activity View form by selecting:

- View icon,
- Customize icon:

The Options icon allow the formatting of text on the bars:

The option to select a Blank name by the bar did not work on the author’s system when the books was written. To prevent a bar name being displayed the author used a blank field so no name was displayed by the bar. This could be a Role ID or Resource Name if they are not being assigned, Steps or Feedback if they are not being used,
8.9 Gantt Chart – Timescale

8.9.1 Customize Activity View form – Gantt Chart tab
The options for formatting the bars are self-explanatory and are edited from the Customize Activity View form by selecting:

- View,
- Customize View:

![Customize Activity View form](image)

- Progress Lines will be covered in the UPDATING AN UNRESOURCED SCHEDULE chapter.

8.9.2 Right-click in Timescale Options
- The Timescale may also be formatted by right clicking in the Timescale:

![Timescale Options](image)

- Non work time shading is shown in the picture above is derived from the Database Default Calendar set in the Administer, Application Settings, Global Calendars.
8.9.3 Zoom to fit Icon

The timescale should be made to fit the available area on the screen by clicking on the Zoom to fit toolbar icon.

This function did not operate as expected in the author's system at the time of writing this book and resulted in the timescale being set with the bars being made extremely short as per the picture below. This may be fixed with a service pack.

8.9.4 Dragging the Timescale

The timescale may be adjusted to fit an area.

This function does not work in the same way as the Professional and Optional Client.

Using the picture above as a starting point:

- The mouse was left clicked in the middle of November,
- Let go of the mouse button,
- Move the mouse to the middle of February,
- This will drag the black shading,
- The picture will look as per below:

- Left-click in the middle of February and the timescale will expand to fill from the middle of November to the middle of February:

It is not possible for users to display different nonwork periods for different projects or views, as in most other scheduling software packages, without affecting all other projects in a database. This may become an issue with projects that have different work periods and may be solved by creating another database with a different Database Default Calendar.
8.10 Activity Network

The Activity Network view is displayed by ![Activity Network icon](image).

The Activity Network is formatted in the Customize Activity View form, Activity Network tab:

![Customize Activity View form](image)

This will be covered in more detail in the **ACTIVITY NETWORK VIEW** chapter.

8.11 Table View

The Table View is displayed by ![Table icon](image) and hides the Gantt Chart allowing a tabular report to be printed.
8.12 Calendar View

The Calendar View is displayed by the Table icon and displays a view that is similar to a Microsoft Project Calendar View:

Double clicking on a day opens up the Day View.

8.13 Access – Sharing Views with Other Users

This tab allows a user to share a view with all people or specific users:
8.14 Workshop 6 – Formatting the Bar Chart

Background

Management has received your draft report and requests some changes to the presentation.
Depending on the settings, your Gantt Chart view may differ from that shown, e.g., there may be no critical bars for example.

Assignment

We will create a new view showing the dates, durations and float only:

1. Select the Projects, Activities to open the Activities Window,
2. Assign a view that has the activities organized by WBS.
3. Create a new view using the Save View As icon titled Workshop 6- Dates & Durations.
4. Customize the View as per the pictures below:

![Customize Columns](image)

Continued…
Sample book with only two chapters

Continued...
Set Label Name as “blank” from the drop down list.

NOTE: The author found that the blank option would not save. In this situation, if you do not want to show a label on a bar, you may wish to assign a value that is blank such as Role ID or Feedback from Resource.

Set this color to Red.
5. Adjust the column widths so they are all optimized,

6. Show, hide and then show again the full screen by clicking on the icon three times,

7. Assign the OzBuild 6d/w calendar to activities A1070 and A1080,

8. Press F9 to open the Schedule Project form and schedule by clicking on the Schedule icon,

9. Format Timescale to fit by using the toolbar icon,

10. Then use the Drag the Timescale function to resize the timescale,

11. Save your view,

12. Your full screen should look like this and the red bar is the critical path:
13 SCHEDULING OPTIONS AND SETTING A BASELINE

Tracking Progress is used after you have completed the plan, or have completed sufficient iterations to reach an acceptable plan, and the project may be progressing. Now the important phase of regular monitoring and control begins. This process is important to help identify problems as early as possible, and thus minimize their impact on the successful completion of the project. The main steps for monitoring progress are:

- Saving a Baseline schedule, also known as a Target. This schedule holds the dates against which progress is compared. The current project may be copied and used as a baseline or an existing project may be assigned as a baseline.
- Recording or marking-up progress as of a specific date, titled the Data Date. This date is also known as the Status Date, Update Date, Current Date, Report Date, and As-Of-Date.
- Updating or Progressing the schedule.
- Scheduling the project and at the same time moving the Data Date to the new Data Date and recalculating all the activities dates.
- Comparing and Reporting actual progress against planned progress and revising the plan and schedule, if required.

Comparing the status of an activity against more than one baseline is useful; for example:

- The original plan could be represented as one of the Baselines, to see the slippage against the original plan.
- Last Period, which could be another Baseline, to see the changes since the last update.

Primavera has the following functions:

- Primavera allows an unlimited number of baseline project files to be saved with a project.
- A baseline project may not be opened and viewed. It must be restored to the database to open and edit where it will therefore no longer be a baseline.
- The two Baselines may be shown against a current schedule at one time either as bars on the Gantt Chart or in columns of data.
- Baseline comparison is displayed at Activity level in the Activities Window, not at resource level.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving and Deleting and Setting a Baseline</td>
<td>To save a Baseline, click on the Define Baseline icon to open the Baselines form, then Click on the Add icon to create a copy of the current project, or Click on the Convert a Project to a Baseline icon which will take another project and make it into a Baseline. Click on the Delete to delete a selected Baseline.</td>
</tr>
<tr>
<td>Setting a Baseline project</td>
<td>The baselines are assigned from Baselines form.</td>
</tr>
</tbody>
</table>

Only some baseline data may be displayed in columns. The Windows Client allows four Baselines bars, the Web Client only two.

Shortcuts:
13.1 Understanding Date Fields

Primavera has many more date fields for the current schedule than P3, SureTrak, Asta Powerproject or Microsoft Project. This section explains how these date fields calculate.

There is very little documentation available on how these dates are calculated and the author has ascertained the information contained in this chapter by trial using an unresourced schedule.

After you understand these date fields, you should look again at the Bar Timescale options in the Bars form and it will be easier for you to understand how the bar formatting works.

13.1.1 Early Start and Early Finish

These are always the earliest dates that un-started activities or the incomplete portions of in-progress activities may start or finish based on calendars, relationships and constraints.

- The Early Start of the completed activity A1000 is set to the Data Date date and time after the activity has commenced, not to the Actual Start, as in most other software,
- The Early Finish of the completed activity A1000 is set to the Data Date date and time when the activity is complete, not to the Actual Finish, as in most other software,
- The Early Start of an in-progress activity A1010 is set to the Activity Remaining start after the activity has commenced, not to the Actual Start, as in most other software.

NOTE: Look carefully at bars and then the dates:

- A1000, the Early Start and Early Finish are equal to the Data Date, and
- A1010, the Early Start is set to the Activity Remaining Early Start:

Thus the Early Start and Early Finish dates of completed activities and Early Start of in-progress activities is not displayed in other software in this way and often leads to confusion when users are converting from other software.

13.1.2 Late Start and Late Finish

- These are the latest dates that un-started activities or the incomplete portions of in-progress activities may start or finish based on calendars, relationships, and constraints.
- The Complete activity has the Late Dates set the date that is equivalent to the latest point in time that the task could be restarted.
- The Total Float on the Complete Task is “Null” but it still shows a Float Bar.

The end of the Total Float bar is the same date and time as the Late Finish and used to calculate Total Float.

---

This publication is only sold as a bound book and no parts may be reproduced by any means, electronic or print. © Eastwood Harris Pty Ltd 176
13.1.3 Actual Start and Finish

These dates are manually applied, representing when an activity started or finished, and override constraints and relationships. These dates should be set in the past in relation to the Data Date.

Actual dates should never change after they are assigned but both the Apply Actuals when activities are set to Auto Compute Actuals, and the Windows Client Update Progress functions may change Actual Dates. These functions must be used with extreme caution.

13.1.4 Start and Finish

The Start is set to the Early Start when the activity has not started and the Actual Start when it has started.

The Finish is set to the Early Finish when the activity has not started or is in-progress and the Actual Finish when it is complete.

- An “A” is placed after the date when an Actual Start or Actual Finish has been set,
- An “*” is placed after the date when a start constraint has been applied to the activity,
- These date fields allow the Early and Actual Start and Finish dates to be displayed as expected when the activity has not started, is in-progress, or complete:

Users converting from P3 and SureTrak will be used to displaying the Early Start and Early Finish dates, but the Early Start and Early Finish dates should not be displayed when a schedule has progress, as this will give misleading information. The Start and Finish dates should always be displayed under normal scheduling conditions.

13.1.5 Planned Start and Finish

The Planned Finish is calculated from the Planned Start plus the Planned Duration. The Planned Duration is labeled Original Duration in some Windows Client Industry Versions. These fields are always linked, therefore:

- A change to the Planned Start will change the Planned Finish via the Planned Duration,
- A change to the Planned Finish will change permanently the Planned Duration, and
- A change to the Planned Duration will change the Planned Finish.
When an activity has NOT started:

- The **Planned** dates ARE normally linked to the **Start** and **Finish** when an activity has not started.

  The **Planned** and **At Completion** durations are **ONLY** linked when an activity has not started and when **Link planned and at completion for not started activities** box in the **Projects Preferences, Calculations** tab is checked.

- They are **NOT** linked to the **Early Dates**.
- A **Planned Start** may be manually edited and as the **Start** date is linked it is also changed, but the **Early Start** is **NOT** changed. The **Planned Start** and **Start** are reset to the Early Dates when a project is scheduled.
- The **Planned Finish** may be edited and is linked to the **Finish** date and the **Planned Duration**. A change to the **Planned Finish** will change the **Finish** date and **Planned Duration**. Rescheduling will recalculate the schedule using the new **Planned Duration** and set the **Planned Finish**, **Finish**, and **Early Finish** to the same date.
- Thus a change to the **Planned Start** is reversed by rescheduling, but a change to the **Planned Finish** affects the **Planned Duration** and is not reversed by rescheduling.

When an activity is in-progress:

- The **Planned Start** date remains unchanged when an **Actual Start** date is set which is different from the **Planned Start**. Therefore the **Planned Start** remains the same as the **Start Date** before the **Actual Start** was set.
- The **Planned Finish** is calculated from the **Planned Start Date** plus the **Planned Duration**.
- After an activity has commenced, the **Remaining Duration** may be edited independently from the **Planned Duration**. The **Planned Finish** may have a different date from the **Finish**, which is now set to equal the **Early Finish**.

When an activity is complete:

- The **Planned Dates** are unlinked from all other date fields.

### 13.1.6 Planned Dates Issues

This is one of the most important paragraphs in this book and you must be certain that you understand the Planned dates and how to avoid the issues associated with them.

The Planned Dates are very complex to explain and understand, so please read carefully. To summarize the statements above:

- When an activity has **Not Started** the Planned Dates match the Early Start and Early Finish.
- When an activity is **Complete** or **In-progress** the Planned Duration, Start and Finish Dates are set to the status of the activity immediately before it was marked as Started.

In the situation where a schedule is in the process of being updated:

- Assume the Data Date has been moved to the new Data Date and the project scheduled,
- Now all un-started activities will have their Start and Finish dates in the future,
- At this point every activity that is marked In-progress by assigning an Actual Start (which should be in the past in relation to the Data Date) will have Planned Dates that **NEITHER**:
  - Match the status of the activity before the activity was marked as Started, nor
  - Match the status of the activity after the activity was marked as Started and possibly Finished.

  Thus in this situation and at this point in time the Planned Dates are now holding irrelevant dates that should never be displayed or used for any purpose.
Unfortunately the Planned Dates are used by default in several places and Database Administrators and Users must be aware of where they are used and how to avoid displaying them.

- The Planned dates are displayed as the Project Baseline bars and Primary User’s Baseline bars when no baseline has been assigned.
  
  Never display a Baseline Bar or columns unless a baseline project has been created and assigned, otherwise the Baseline bar and columns may represent irrelevant data.

- These Planned dates are used by the Apply Actuals function, when activities are set to Auto Compute Actuals, and the Windows Client Update Progress function. Thus Actual Start dates and Early Finish dates of in-progress activities will be changed to the Planned Date values without warning.

  Ensure you never ever use the Apply Actuals function on a schedule that has been progressed, otherwise Actual Start dates and Early Finish dates of in-progress activities will be changed to the Planned Dates values without warning.

- The Planned Dates from a Baseline schedule will be displayed as the Baseline Bars when the Administer, Application Settings, Earned Value tab is set to Planned values with planned dates. Thus the Baseline Bars from an in-progress schedule will be incorrect.

  Ensure Administer, Application Settings, Earned Value tab has this value set as At Completion values with current dates or Planned Values with current dates. When the schedule is not resource or cost-loaded it does not matter which of these two you use.

### 13.1.7 Remaining Early Start and Finish

These are the earliest dates that the incomplete portions of un-started or in-progress activities may start and finish.

- They are blank (null) when an activity is complete.
- They may be edited in the same way as Planned Dates.

  When a Remaining Early Start is edited to a date later than scheduled date, there is an option for constraining the Remaining Early Start with a Start on or After Constraint. If this is not set then the activity will move forward to its original position when scheduling.

  When a Remaining Early Finish is edited, the Remaining Duration is also edited and the change is permanent. Scheduling does not take the schedule back to the original position.
13.1.8 Remaining Late Start and Finish
These are the latest dates that the incomplete portions of activities may start and finish.

- They are blank when an activity is complete and may not be edited,
- They are set to equal the Late Dates.

<table>
<thead>
<tr>
<th>Activity ID</th>
<th>Remaining Late Start</th>
<th>Remaining Late Finish</th>
<th>September 2014</th>
<th>October 2014</th>
<th>November 2014</th>
<th>December 2014</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1000</td>
<td></td>
<td></td>
<td>31</td>
<td>07</td>
<td>14</td>
<td>21</td>
</tr>
<tr>
<td>A1010</td>
<td>27-Oct-14 09</td>
<td>07-Nov-14 16</td>
<td>26</td>
<td>05</td>
<td>02</td>
<td>09</td>
</tr>
<tr>
<td>A1020</td>
<td>10-Nov-14 08</td>
<td>05-Dec-14 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

13.2 Scheduling Options – General Tab
When a project is rescheduled there are some options available in the Schedule Project, Options form, General tab which is opened by selecting Scheduler, Options:

- There is no icon that will set the options back to the P6 defaults as in the Windows Client.
- The default options are usually good defaults but some need to be changed to suit specific situations.
- These options apply to all activities in the currently opened schedule.
When opening multiple projects in the Web it calculates differently to the Windows Client. The Windows Client has a **Default Project** option that does not exist in the Web.

- In the Web tool the **Schedule Options** of the project listed at the top of the opened projects list (which will rearrange when you close the form to an alphabetical list) is used to calculate all projects and (unlike the Windows Client) will not change the **Schedule Options** of the other opened projects. Thus a change to your Project ID opened with other projects may result in a project calculating differently if the project is pushed down the list of opened projects and when the project at the top of the list has different Scheduling Options.

- In the Windows Client the **Schedule Options** of the **Default Project** are used to calculate all the open projects and the **Schedule Options** for non-default projects are then changed permanently to those of the **Default Project**, so they will never calculate the same way when opened on their own.

- Changing the **Schedule Options** may change the way the schedule calculates and users must be very careful if considering changing any of them. You may wish to copy the schedule, baseline it, and then change to options to see what the effect is on the schedule calculation.

Setting a Project Schedule Service to schedule multiple projects allows the nomination of **Use this project’s settings** option.

### 13.2.1 Ignore relationships to and from other projects (& Ignore External Dates)

Check this to ignore relationships with other projects that are currently not open.

These relationships may be created between two projects when two or more projects are opened together.

This option will also ignore **External Dates**, which are the **External Early Start** and **External Late Finish** dates.

**External Dates** are constraints created when a project is exported from Primavera Contractor and/or another P6 database and imported into P6. They act like Early Start and Late Finish Constraints and are used to represent the relationships that would have originally provided the Early Start and Late Finish dates to the Critical Path calculations of the imported schedule.

These dates can be very confusing if one is not aware that they have been created or how they operate. The negative float in the picture below is created by these dates after an activity’s duration was increased by 34 days:

<table>
<thead>
<tr>
<th>Activity ID</th>
<th>External Early Start</th>
<th>External Late Finish</th>
<th>Total Float</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 000</td>
<td>14-Jun-12 16</td>
<td>-15d</td>
<td></td>
</tr>
<tr>
<td>A1 010</td>
<td>01-Jul-12 16</td>
<td>-15d</td>
<td></td>
</tr>
<tr>
<td>A1 020</td>
<td>08-Jul-12 08</td>
<td>-15d</td>
<td></td>
</tr>
</tbody>
</table>

When you import a project from another database ensure you **ALWAYS** check for **External Dates** and understand how they operate.

If you export and then import back into the same database then External dates are not normally created but the relationships are re-established with the original schedule they were linked with.

On the other hand, if the original schedules have been deleted then these External Dates may be created.
13.2.2 Make open-ended activities critical

An open-ended activity is an activity without a successor and which has float to the end of the project. Checking the box makes these activities critical with zero total float when they do not have a successor.

- Open-ends Not Critical:

- Open-ends Critical:

This also allows the user to display multiple critical paths in one project without the use of constraints and is useful should you wish to see the individual critical paths for each area of a project. In order for this function to work the last activity in each chain or events must not have a successor:

- Open-ends Not Critical:

- Open-ends Critical:
13.2.3 Use Expected Finish Dates

The intention of this option is for people using timesheets to be able to set an Expected Finish constraint for an activity.

Once an Expected Finish date is set then the software calculates the Remaining Duration from:

- The Early Start when an activity has not started, or
- The Data Date when an activity has started, or
- A Resume date if a Suspend and resume date has been set.

Therefore Expected finish dates may be assigned from the Timesheets module and this option allows the project manager to ignore these dates submitted with the timesheets.

This is always checked by default and will disable or enable Expected Finish constraints assigned in the General tab of the Activities Details tab or from a column.

This is usually not turned off and the pictures below show the effect of this constraint before and after scheduling an activity with an Expected Finish Constraint assigned:

- Before scheduling:

- After scheduling:

13.2.4 Schedule automatically when a change affects dates – Not in the Web Client

This is similar to automatic recalculation in other products and this recalculates the schedule when data that affects the timing of the schedule is changed and is not available in the Web Client.

P6 is a database product and Schedule Automatically in the Windows Client will result in the schedule recalculating every time you make a change. This may slow down your work significantly; this option is usually left off.

13.2.5 Level resources during scheduling

Leveling a schedule delays activities until resources become available. This is a form of resource optimization and this option levels the project resources each time it is scheduled. Resource leveling is covered in the Professional and Optional Client book.

This is NOT recommended as it slows down the schedule calculation and the schedule often changes each time it is scheduled.

It is usually better to use sequencing relationships to level a schedule.
13.2.6 Recalculate assignment costs after scheduling

Resource Unit Rates may be set to change over time in the Units and Prices tab of the Administration, Resources Window lower pane:

This option recalculates a resource cost when a resource is scheduled into a different cost rates time bracket.

13.2.7 When scheduling progressed activities use

“Out of Sequence Progress” occurs when an activity starts before a predecessor defined by a relationship has finished. Therefore the relationships have not been acknowledged and the successor activity has started out of sequence. There are three options in P6 for calculating the finish date of a successor when the successor activity has started before the predecessor activity is finished:

- Retained Logic
- Progress Override
- Actual Dates

The selected option is applied to all activities in a schedule when it is calculated. Open the Schedule Options form, General tab by selecting Scheduler and clicking on the, Options icon where the options are found under When scheduling progressed activities use:

The picture below represents the status of the activities before updating the schedule:
- **Retained Logic.**
  In the example following, the relationship is maintained between the predecessor and successor for the unworked portion of the activity (the Remaining Duration) and continued after the predecessor has finished. The relationship forms part of the critical path and the predecessor has no float.
  
  **NOTE:** This is the recommended option:

  ![Diagram showing Retained Logic](image)

  The Windows Client picture is clearer in showing the result:

  ![Windows Client showing Retained Logic](image)

- **Progress Override.**
  In the example following, the Finish-to-Start relationship between the predecessor and successor is disregarded, and the unworked portion of the activity (the Remaining Duration) continues before the predecessor has finished.
  
  **NOTE:** The relationship is not a driving relationship and DOES NOT form part of the critical path in the example below and the predecessor has float:

  ![Diagram showing Progress Override](image)

  The Windows Client picture shows a similar result:

  ![Windows Client showing Progress Override](image)
• **Actual Dates.**

This function operates when there is an activity with Actual Start Dates in the future, which is not logical. With this option the remaining duration of an in-progress activity is calculated after the activity with actual start and finish in the future:

| 31 | 07 | 14 | 21 | 28 |

![Diagram showing actual dates](image)

The Windows Client picture is clearer in showing the result:

When there are no Actual Dates in the future this option calculates as Retained Logic.

This situation with Actuals in the future may happen when two projects open together and have different Data Dates. This situation is best avoided and it is better to make all the Data Dates of all projects the same.

Retained Logic and Progress Override are not terms used by Microsoft Project but are used in P3 and SureTrak and operate in the same way in Primavera. Microsoft Project uses the term Split in Progress.

Retained Logic produces a more conservative schedule (a longer duration schedule) and is more likely to place an out-of-progress relationship on the critical path and adjustments may be made as required.

If your schedule has Actual dates in the future of the Data Date (which may occur when the update information is collected at different times and the earlier date is used as the Data Date or multiple projects are open) then the use of Actual Dates would calculate the most conservative schedule.
13.2.8 Calculate start-to-start lag from
The successor of an activity with a Start-to-Start and positive lag would start after the lag has expired. When the predecessor commences out of sequence the lag may be calculated from the predecessor calculated Early Start or the Actual Start.

- The **Actual Start** gives a less conservative schedule:

<table>
<thead>
<tr>
<th>Activity ID</th>
<th>Activity Name</th>
<th>November 2014</th>
<th>December 2014</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1000</td>
<td>First Activity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1010</td>
<td>Second Activity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1020</td>
<td>Start to Start + 10 days</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Windows Client picture is clearer in showing the result:

- The **Early Start** gives a more conservative schedule:

<table>
<thead>
<tr>
<th>Activity ID</th>
<th>Activity Name</th>
<th>November 2014</th>
<th>December 2014</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1000</td>
<td>First Activity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1010</td>
<td>Second Activity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1020</td>
<td>Start to Start + 10 days</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Windows Client picture is clearer in showing the result:

13.2.9 Define critical activities as
Critical Activities Definition criteria is defined in the Schedule Project, Options form:

These options are used for analyzing schedules that utilize multiple calendars which may result in activities on the critical path possessing float.

- **Total Float less than or equal to** – Activities may be marked as critical and with a chosen float value. Sometimes a small positive value is used to isolate the near critical activities on schedules or displaying the full critical path on multiple calendar schedules.
- **Longest Path** – This option isolates the longest chain of activities in a schedule and should be used when multiple calendars are in use and some activities, which form part of the critical path, still have float when the successor is assigned a calendar with fewer or different working days.
In the example below the Total Float has been set to **Total Float less than or equal to zero** and the critical path has disappeared:

<table>
<thead>
<tr>
<th>Total Float</th>
<th>Critical</th>
<th>Nov 23</th>
<th>Nov 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>1d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When the Total Float is then set to less than or equal to 1 day results in the picture below:

<table>
<thead>
<tr>
<th>Total Float</th>
<th>Critical</th>
<th>Nov 23</th>
<th>Nov 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>1d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When the total Float is then set to **Longest Path** results in the picture below:

<table>
<thead>
<tr>
<th>Total Float</th>
<th>Critical</th>
<th>Nov 23</th>
<th>Nov 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>1d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0d</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Longest path is recommended for projects with multiple calendars.

13.2.10 **Calculate float based on finish date**

This is a new function to Version 6.2. When more than one project is opened the Total Float may be calculated based on each individual project or the longest project:

- **Each project** – used when each project’s critical path is required:

<table>
<thead>
<tr>
<th>PMS / Activity △</th>
<th>Total Float</th>
<th>May 2012</th>
<th>June 2012</th>
<th>July 2012</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>23</td>
<td>27</td>
<td>03</td>
</tr>
<tr>
<td>Project 1</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1000</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1010</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1020</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1030</td>
<td>10d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project 2</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1000</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1010</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1020</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1030</td>
<td>25d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project 3</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1000</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1010</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1020</td>
<td>0d</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1030</td>
<td>40d</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
13.2.11 Compute Total Float as

There are three options for the calculation of the Float value displayed in the Total Float column of WBS and LOE activities only:

- **Start Float = Late Start – Early Start**
- **Finish Float = Late Finish – Early Finish**
- **Smallest of Start Float and Finish Float**

It can be seen from the pictures above that the Total Float bar only displays the Finish Float. The Smallest of Start Float and Finish Float is the most conservative but the Finish Float will always give an answer that is the same as the Total Float bar.
13.2.12 Calendar for scheduling Relationship Lag

There are four calendar options for the calculation of the lag for all activities:

1. **Predecessor Activity Calendar** is the default. The example below has a 40-hour lag, or 5 days as the lag calendar is 8 hour per day:

<table>
<thead>
<tr>
<th>Calendar</th>
<th>Nov 23</th>
<th>Nov 30</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S  M  T</td>
<td>W  T  F</td>
</tr>
<tr>
<td>5 day/week 8 hour/day</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 day/week 24 hour/day</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. **Successor Activity** Calendar, note the change in the successor start date as the lag calendar is 24 hours per days or 1.66 day:

<table>
<thead>
<tr>
<th>Calendar</th>
<th>Nov 23</th>
<th>Nov 30</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S  M  T</td>
<td>W  T  F</td>
</tr>
<tr>
<td>5 day/week 8 hour/day</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 day/week 24 hour/day</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. **24-Hour**, or

4. **Project Default Calendar**

   P3 and SureTrak use the predecessor calendar, Microsoft Project 2000 and 2002 uses the Project Base calendar, and Microsoft Project 2003 to 2010 uses the successor calendar. Microsoft Project also has the option of an Elapsed lag duration. Asta Powerproject does not assign lags to the relationship but a relationship may be assigned a lag on the predecessor activity and a lag on the successor activity, which is more logical.

13.2.13 Scheduling Options – Advanced Tab

This tab selects the options for calculating multiple critical paths and is covered in detail in the Utilities chapter of the Professional and Optional Client book.
13.3 Setting the Baseline

Setting the Baseline makes a complete copy of a project, including relationships, notebook entries and codes. You are then able to compare the current project’s progress against the baseline.

There are two types of Baselines that are often saved with scheduling software such as P6 – Management and Last Period Status:

Management Baselines

These are usually a copy of an original unprogressed schedule that has been contractually agreed to as the Baseline or Target schedule and are used to:

- Evaluate progress and report progress to a Client or customer,
- Provide a base for Extension of Time claims and other contractual claims that may be made based on these Baseline schedules.

Last Period Status Baselines

These are copies of a schedule at a point in time and are used for the management of a project:

- Usually they are used to measure the loss in time from one reporting period to another,
- They allow management to ascertain performance and make decisions on how to manage the project,
- They are displayed in exactly the same way as Management Baselines with the software,
- These Baselines usually, after the first period update, have progress.

Up to 50 baselines per project may be saved in a database in earlier versions but in Version 6.0 and later an unlimited number may be saved.

There is still a restriction of copying a maximum of 50 Baselines when copying a project.

- The number of baselines that may be saved is set in the Administer, Application Settings, Data Limits form by selecting Administer, Application Settings, Data Limits and setting the number in the Maximum baselines per project box.
- The number of baselines that may be copied when copying a project is set in the Data Limits form by selecting Administer, Application Settings, Data Limits and setting the number in the Maximum baselines copied with project box.
- Two baselines, one Project Baseline and one User Baselines, may be displayed and compared to the current project. The Windows Client may display 4 Baselines.

If another user opens the project, they will only see the one Project Baseline and not the User’s Baseline set by another user.

- A baseline project may be restored back into a database as a normal project. Then it may be edited and resaved as a baseline project.

After the Baseline is set, it is possible to compare the progress with the original plan. You will be able to see if you are ahead or behind schedule and by how much. The Baseline schedule should be established before you update the schedule for the first time.
13.3.1 Creating a Baseline
To create a Baseline, ensure the project is open and select Project, Activities Window, select Actions, Define Baselines to display the Baselines form:

- To create a new baseline click the Add icon,
- Click the Copy icon to create a copy of the selected baseline project as a new Baseline,
- Click the Convert a project to Baseline will open the Select Project form where another project may be selected to be a baseline. This project will then move from the current projects window into the Baselines form and is not available to be opened from the Projects, EPS Window.
- Click the Save icon to save all changes,
- Click the Cancel icon to ignore all changes.

You may have to close the form and reopen to refresh the data in this form.

13.3.2 Deleting a Baseline
To delete a project baseline from the database:
- Open the Baselines form,
- Select the baseline project to be deleted, and
- Click the Delete icon to delete a Baseline.

13.3.3 Restoring a Baseline to the Database as an Active Project
To restore a project back to the database so it may be edited or used as a current project:
- Open the Baselines form,
- Ensure the baseline is not assigned as any baseline in the Baselines form,
- Select the baseline project to be restored, and
- Click on the Restore icon.
13.3.4 Update Baselines
The Windows Client Update Baseline function was added to the Web in Version 8.4. This allows the modification of an existing Baseline with new or changed data from the current schedule as an alternative to creating a new baseline.

To Update a Baseline:
- Select the EPS or Activities Page, Actions menu Define Baselines,
- Select a baseline Baselines form, and
- Click on the Update Baseline icon.

13.3.5 Copying a Project with Baselines
You may copy baselines when a project is copied in the EPS Window using Copy and Paste by ticking the appropriate boxes.
13.3.6 Setting the Baseline Project

To assign a Project Baseline or User’s Primary Baseline:

- Open the Baselines form,
- Select the baseline project to be assigned,
- Select the required Project Baseline or User’s Primary Baseline from the appropriate columns drop down box,
- Baseline Types are optional and are defined in the Administer, Enterprise Data form, Baseline Type tab:

![Baseline Form]

- The Project Baseline or User’s Primary Baseline may be used for calculating Earned Value. See Administer, Application Settings, Earned Value tab for other Earned Value options. This Baseline is seen by any User who opens the project.
- Secondary and Tertiary User Baselines in the Windows Client are not available in the Web.
- The User’s Primary Baseline are only seen by the User who has set the Baseline. So other users who open a project and apply, for example, a Project View that displays a User Baseline, will have to also make sure that they set the same baseline as the original user.

Earned Value calculations may be performed using either the Primary Baseline values or the User’s Primary Baseline values from the current project. Select the Settings tab in the Projects, EPS Window, Actions, Set Project Preferences:

![Project Preferences Window]
• The Administer, Application Settings, Earned Value tab, Earned value section has three options. This option decides which Baseline schedule values are read to calculate the Earned Value fields and which bars are displayed as Baseline Bars. The At Completion values with current dates is the author’s preferred option when resources are assigned.

When the Planned values with planned dates is selected, which is often the default value when the software is loaded, then the Planned Dates are displayed as a baseline bar. This is undesirable when a progressed schedule is displayed as a Baseline, say, for comparing this period’s date values with last period’s date values. This is because the Planned Dates often hold irrelevant data when a Baseline schedule has progress.

13.3.7 Understanding the <Current Project> Baseline
Because Planned Dates are difficult to understand and may lead to misinterpretation of the schedule baselines, it is important that you understand the following points:

• The Planned Dates are used by the <Current Project> Baseline in the Define Baseline form.
• The <Current Project> Baseline is the default baseline for both the Project Baseline and Primary User’s Baseline.
• When NO baseline has been set by a user then the <Current Project> Baseline and therefore the Planned Dates are displayed as the Baseline Bars.
• The <Current Project> Baseline is not a true baseline, the dates may change each time a schedule is updated and may hold irrelevant data in a schedule that has been progressed.
• The term Current Project is normally used to describe the activities as they are currently scheduled, and the term <Current Project> Baseline is confusing as it is not the Current Project but the Planned Dates, which may be different from the normally accepted Current Project.

The following picture has three bars:

• The upper bar represents the Start and Finish dates:
  ➢ The Start date is set to the Early Start when an activity has not started and Actual Start when the activity has started.
  ➢ The Finish date is set to the Early Finish when an activity has not finished and Actual Finish when the activity is complete.
• The middle bar is the <Current Project> baseline, the Planned Dates, and
• The lower bar is a proper Project Baseline made by copying the un-progressed project.
With no progress all bars are the same, see picture below:

In the following picture:

- Activity 1 has been marked complete and the Data Date moved.
- The Planned Dates for Activity 1 equal the Start and Finish date before the activity was marked as started.
- The un-started activities, Activity 2 and 3, in the <Current Project> baseline which represent the Planned Dates have changed their dates to equal the Start and Finish, see picture below:

In the following picture:

- Activity 2 has now been marked in-progress and the Data Date NOT moved.
- Now Activity 2 Planned Dates (represented by the <Current Project> baseline) match the status of the activity before it was marked Started, not a Baseline. This activity Planned Dates now display irrelevant data,
- Activity 3 Planned Dates represented by the <Current Project> baseline bars have changed a second time and match the new Start and Finish:

When no Baseline is set by the user, the project will DISPLAY the <Current Project> from the Planned Dates, not the current project Start and Finish dates) as the Baseline bars and, in effect:

All un-started activities are effectively “re-baselined” at each schedule update, and Started and Complete activities Planned Dates match the Start and Finish dates of the activity just before an activity was marked as started. Therefore, the Planned Dates of these activities could contain irrelevant data. This happens when a project has been rescheduled and the Data Date moved forward and then activities marked as Started. At this point the Planned Dates now do not represent a Baseline, the last period status or the next period status of an activity. They contain irrelevant data that should never be displayed, as per the picture above. This is generally not accepted as a good practice.
There are some significant issues here that need to be carefully managed:

- If no Baseline is set and a view that displays a baseline bar is applied, then a baseline bar may contain irrelevant dates from the Planned Dates will be displayed. This may create confusion and these bars may change on each schedule update.
- If one user sets a Primary User’s Baseline and therefore only seen by that user, and a different user opens a project, then this second user will see only the <Current Project> baseline and not the other Primary User’s Baseline. This will result in one user seeing something different from another user when two users open a project.

You may wish to restrict the access to a project schedule to prevent the <Current Project> baseline being displayed inadvertently.

13.3.8 Displaying the Baseline Data

The Baseline Dates may be displayed by:

- Displaying the Baseline columns:
  - BL is the Project Baseline
  - BL1 is the User Primary Baseline

<table>
<thead>
<tr>
<th>Activity Name</th>
<th>Start</th>
<th>Finish</th>
<th>BL1 Start</th>
<th>BL1 Finish</th>
</tr>
</thead>
<tbody>
<tr>
<td>BL Technical</td>
<td>02-Dec-13</td>
<td>27-Jan-14</td>
<td>02-Dec-13</td>
<td>27-Jan-14</td>
</tr>
<tr>
<td>O21000 Approve JPL</td>
<td>02-Dec-13</td>
<td>02-Dec-13</td>
<td>02-Dec-13</td>
<td>02-Dec-13</td>
</tr>
<tr>
<td>O21010 Determine JPL</td>
<td>02-Dec-13</td>
<td>06-Dec-13</td>
<td>02-Dec-13</td>
<td>06-Dec-13</td>
</tr>
<tr>
<td>O21020 Create Technical</td>
<td>06-Dec-13</td>
<td>12-Dec-13</td>
<td>06-Dec-13</td>
<td>12-Dec-13</td>
</tr>
<tr>
<td>O21030 Identify Suppliers</td>
<td>16-Dec-13</td>
<td>16-Dec-13</td>
<td>16-Dec-13</td>
<td>16-Dec-13</td>
</tr>
<tr>
<td>O21040 Validate Technical</td>
<td>16-Dec-13</td>
<td>17-Dec-13</td>
<td>16-Dec-13</td>
<td>17-Dec-13</td>
</tr>
<tr>
<td>Delivery Plan</td>
<td>19-Dec-13</td>
<td>21-Jan-14</td>
<td>19-Dec-13</td>
<td>21-Jan-14</td>
</tr>
<tr>
<td>O21050 Document Deliver</td>
<td>19-Dec-13</td>
<td>24-Dec-13</td>
<td>19-Dec-13</td>
<td>24-Dec-13</td>
</tr>
<tr>
<td>O21060 Obtain Guides</td>
<td>02-Jan-14</td>
<td>13-Jan-14</td>
<td>02-Jan-14</td>
<td>13-Jan-14</td>
</tr>
<tr>
<td>O21070 Calculate the El</td>
<td>14-Jan-14</td>
<td>14-Jan-14</td>
<td>14-Jan-14</td>
<td>14-Jan-14</td>
</tr>
<tr>
<td>O21080 Create the Project</td>
<td>17-Jan-14</td>
<td>20-Jan-14</td>
<td>17-Jan-14</td>
<td>20-Jan-14</td>
</tr>
<tr>
<td>O21090 Review the Deliver</td>
<td>21-Jan-14</td>
<td>21-Jan-14</td>
<td>21-Jan-14</td>
<td>21-Jan-14</td>
</tr>
</tbody>
</table>

- Showing a baseline bar on the Bar Chart by selecting the appropriate bars in the Customize Gantt Chart Options form, Bars tab:

The Windows Client BL2, the Secondary User Baseline and BL3, the Tertiary User Baseline may not be displayed in the Web Client.
13.4 Additional Baseline Fields

P6 R8.3 has added extra baseline fields in the Customize Columns form to be displayed on the Activities window after a baseline has been assigned to a project.

The new fields are available for the project baseline (BL) and user’s primary baseline (BL1):

- Actual Expense Cost
- Actual Labor Cost
- Actual Material Cost
- Actual Nonlabor Cost
- Actual Total Cost
- Actual Start
- Actual Finish
- Early Start
- Early Finish
- Late Start
- Late Finish
- Actual Duration
- Remaining Duration
- Free Float
- Total Float
- Activity Status
- Activity % Complete
- Cost % Complete
- Duration % Complete
- % Complete Type
- Units % Complete
- Actual Labor Units
- Actual Nonlabor Units
To access this functionality:

- In the Activities window on the Projects section, go to **View** and select **Columns** or;
- Click on the **Columns** button located in the toolbar.

Duration baseline fields
Sample book with only two chapters
13.5 Workshop 11 – WBS, LOEs and Setting the Baseline

Background
We will first look at how WBS and LOE activities work and then set a Baseline.

Assignment – WBS Activity
Open your OzBuild Bid project file and complete the following steps:

1. Apply the Workshop 6 Dates & Duration view, check the columns are as per the picture below,
2. Display the Float Bar as the Second bar, in black with a height of 4,
3. Create a new activity under the Bid Document WBS Node, ID OZ1140 titled WBS Activity,
4. Assign an Activity Type of WBS Summary using the Activities Window, General tab.
5. Save and press F9 to Schedule to see how it calculates.
6. Move the WBS Activity to the Delivery Plan WBS Node by copying and pasting and schedule to see how it operates.
7. Move the WBS Activity using Cut and Paste to the Technical Specification WBS Node and schedule:

   - Go to the Scheduler (F9), Options form and change the Compute Total Float to Start Float:
   - Schedule and you will see that the float value is now the same value as the Start float, but the Float Bar still shows the Finish Float Value:
   - Go to the Scheduling Options form and change the Compute Total Float to Finish Float and schedule.

Sample book with only two chapters
Assignment – LOE Activity

11. Change the WBS Activity Type to a Level of Effort and rename it to LOE Activity.

12. Do not schedule with a LOE activity unless it has relationships. If you do schedule it will calculate to a zero duration and be marked as Complete on the Data Date. You will then have to mark it as not started in the Activities Window, General tab and assign a duration so you can see it on the Gantt Chart.

13. Move OZ1140 to the Delivery Plan WBS Node and sort on Activity ID.

14. Add OZ1060 SS OZ1140 predecessor and OZ1140 FF OZ1070 successor relationships and see how it calculates.

   Ensure you open the Predecessor and Successor windows and there are only one predecessor and one successor.

15. Add OZ1050 SS OZ1140 predecessor and OZ1140 FF OZ1110 successor relationships and see how it calculates.

16. Delete the LOE activity.
Assignment – Setting a Baseline

17. Select Project, Activities Window, select Actions, Define Baselines to display the Baselines form and click on Add to save a copy of the current project as a Baseline and title it Bid for Facility Extension – Baseline.

18. Assign an appropriate Baseline Type, such as Customer Sign-Off, (the options may vary depending on your database).

19. Make this your Project Baseline and User's Primary Baseline and close the Baselines form. By setting both Baselines, this ensures that any baseline bar will show a real baseline and not the Planned Dates.

20. Save and close the Baselines form.

21. Hide the Float Bar and display the Project Baseline bar, say in yellow and 8 high.

22. Display the following columns:
   - Show first column as – Activity Name
   - Activity ID
   - Activity % Complete
   - Planned Duration
   - Remaining Duration
   - Start
   - Finish
   - Total Float
   - Variance BL – Project Finish Date

23. Make sure the Timescale is Month / Week.

24. Show the time in 24-hour format, but do not show the minutes by selecting Administer, My Preferences, Dates tab.

25. Save your view as Workshop 11 – Baseline Comparison.

Continued…
26. Check your answer below: